DRI EAZ ® Bs;:ﬁguiugeaf:; Logging Software

INTRODUCING DRIHAWK SOFTWARE 1.0

Congratulations on purchasing DriHawk Data Logging Software from Dri-Eaz. DriHawk
Software allows you to take advantage of the data logging capabilities of your Dri-Eaz DriHawk
T-700 Thermo-Hygrometer.

First, it lets you set up the DriHawk to log data on the job. As a data logger, the DriHawk can
record individual readings of temperature and relative humidity at selected intervals. Use this
software to tell your DriHawk how often to take a reading. You choose from one reading every
second all the way up to one reading every 30 minutes. The DriHawk can record up to 4000
readings across 16 separate Log Cycles, so you can log data for as many as 16 separate rooms
throughout a water-damaged building.

Second, DriHawk Software can produce valuable reports. Once you transfer logged data onto
your computer, the software generates easy-to-read graphs and reports showing temperature,
relative humidity and humidity ratio over time. Print out these reports for the insurance adjuster
and the homeowner as scientific proof that the structure is dry. You can also save data on the
computer for your own records and recall it for future reference.

About this guide

Before you use DriHawk Software, be sure to read this guide for instructions on installing and
using the software. Each section addresses a specific set of tasks using the DriHawk Thermo-
Hygrometer and DriHawk Software.

Install and Run DriHawk Software

Set Up Your DriHawk for Data Logging
Log Data with Your DriHawk

Upload Logged Data to Your Computer
Create Graphs and Reports

Save and Open Logged Data Files

Technical Help
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Register DriHawk Software

These instructions assume a basic familiarity with the Microsoft, Windowsg operating system. In
otder to install and use DriHawk Software, you should feel comfortable using a mouse, moving
between open programs and finding files on your computer.
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What you will need

In order to use DriHawk Software, you'll need the following:
® Dri-Faz DriHawk T-700 Thermo-Hygrometer

® DriHawk Software Installation CD

e DriHawk Software Data Cable

e PC computer with a CD-ROM drive and COM port

Microsoft, Windowsg 95/98/2000 or Windows N'T,, operating system

Microsofte Windowse 95, Windowse 98, Windowse 2000, and Windows NTw are cither registered trademarks or tradematks of Microsoft
Corporation in the United States and/or other countries.

A INSTALL AND RUN DRIHAWK SOFTWARE

DriHawk Software will only work if it is installed on your computer's hard drive. You will need
to install the program from the DriHawk Software installation disc before you can use it.

To install DriHawk Software:

1 Insert the DriHawk Software disc into your computer's CD-ROM drive. The Setup program
should start automatically. If the Setup program does not start automatically, double-click
"Setup.exe" file on the DriHawk Software disc.

2 Follow the instructions in the Setup Wizard. This will include restarting your computer to
finish the installation.

Congratulations! You've successfully installed DriHawk Software.

Note: The setup program automatically installs DriHawk Software in your Programs folder.
Moving DriHawk from your Programs folder will have a negative effect on its performance.

Note: If your operating system is Microsoft, Windows NTg, 4.0, you will need Microsoft's
Service Pack 6 before you can install DriHawk Software. To install the service pack, open the
"NT Service Pack 6" folder on the DriHawk Software installation disk and double-click on the
enclosed file.

To run DriHawk Software:

1 Connect the DriHawk Thermo-Hygrometer to your computer with the included data cable
(refer to section B).

2 Turn on the DriHawk Thermo-Hygrometer.
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3 Double-click on the DriHawk Software icon on your desktop OR select DriHawk Software
from the Programs folder in your Start menu.

When you start the program, you see the DriHawk Main Menu with the Dri-Eaz logo in the
center of your screen (see Fig. 1 below).

Fig. 1 — DriHawk Software Main Menu
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Note: If the DriHawk is not connected and turned on when you run DriHawk Software, you
receive a notice informing you that the unit is not connected. You may click OK and continue to
Open Previous Data Files, but you will not be able to set the unit up for data logging or
upload any data until you close the program and restart with the DriHawk properly connected.

To exit DriHawk Software:
1 Click File in the toolbar at the top of the screen

2  Select Exit.

B SET UP YOUR DRIHAWK FOR DATA LOGGING

Before you take your DriHawk Thermo-Hygrometer to a jobsite, use DriHawk Software to
calibrate it for data logging. This section shows you how to connect your DriHawk to your
computer and set it up to record readings.

To work properly, the DriHawk must be connected to the computer and turned on before you
start DriHawk Software.
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To connect your DriHawk to your computer:

1 Attach the 9-pin plug of the included data cable to the COM port on the back of your
computer. If your computer has more than one COM port, Dri-Eaz recommends using

COM 1.
2 Insert the 1/8-inch plug of the data cable into the jack on the side of the DriHawk.

To set up your DriHawk as a data logger:
1 Turn the DriHawk Thermo-Hygrometer on.

2 Make sure the DriHawk is properly connected to your computer before starting DriHawk
Software.

3 Run DriHawk Software (refer to section A).

4 In the Main Menu, click on DriHawk Logging Setup.

5 In the Logger Setup Menu, select a sample interval. For example, to record one reading
every 10 seconds click the box next to 10 seconds. The menu will approximate the
DriHawk's total logging time for each sample interval (see Fig. 2 below). If you want to

return to the main menu without making any changes, click the Main Menu button.

Fig. 2 — Logger Setup Menu
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6 Click OK to proceed.
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7 A window notifies you that continuing will clear existing Log Cycle information from the
DriHawk Thermo-Hygrometer. Click OK to continue.

8 Exit DriHawk Software before disconnecting the DriHawk.

NOTE: To clear the memory of your DriHawk Thermo-Hygrometer, click the yellow Clear
Log Cycle Data button. WARNING! This will permanently erase any unsaved or
untransferred data from your DriHawk Thermo-Hygrometer's memory.

C LOG DATA WITH YOUR DRIHAWK

Once the DriHawk is set up for data logging with DriHawk Software, you are free to exit
DriHawk Software, unplug the DriHawk and take it to a jobsite. The display reads
"STANDBY," letting you know that the DriHawk is ready to record readings of temperature
and relative humidity at the intervals you selected during the set up process. The DriHawk can
record up to 4000 readings in up to 16 different Log Cycles.

To start a DriHawk Log Cycle:

1 Set up the DriHawk Thermo-Hygrometer for data logging using DriHawk Software (refer to
section B).

2 Exit DriHawk Software.
3 Unplug the DriHawk Thermo-Hygrometer from your computer.

4 You may turn off the DriHawk on your way to or from a jobsite. Turn on the DriHawk
when you are ready to take readings.

5 Place or hold the DriHawk where you wish to log data.

6 Begin the first Log Cycle by pressing the graph button on the DriHawk. Your DriHawk
LCD screen now reads "LOGGING."

7 Leave or hold the DriHawk in place long enough to record more than one reading. For
example, if you set up your DriHawk to record readings every 1 minute, leave the DriHawk
on "LOGGING" for at least 2 minutes to record sufficient data for graphing.

8 Tinish the Log Cycle by pressing the graph button a second time. The LCD screen returns to
"STANDBY."

9  You may repeat for up to 16 Log Cycles or 4000 readings, whichever comes first.
NOTE: You may upload your data to the computer at any time. However, when the DriHawk

has reached 4000 readings or completed 16 Log Cycles, the display will no longer read
"LOGGING" or "STANDBY." At this point, you must upload the data to your computer and
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clear the DriHawk Thermo-Hygrometet's memory before continuing to log data (refer to
sections B and D).
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NOTE: You may turn the DriHawk Thermo-Hygrometet's power on and off without affecting
Log Cycle memory.

D UPLOAD LOGGED DATA TO YOUR COMPUTER

When you've finished logging data at the jobsite with your DriHawk Thermo-Hygrometer, you
can transfer or "upload" the data to your computer using DriHawk Software.

To upload data from your DriHawk:

1 Connect your DriHawk Thermo-Hygrometer to the computer with the included data cable
(refer to section B).

2 Make sure the DriHawk is turned on.

3 Run DriHawk Software (refer to section A).

4 In the DriHawk Main Menu, click Upload Data.

5 Click Next. You receive a "Communication Successful" message.

6 Click OK. A Statistics window displays your uploaded data (see Fig. 3 below).

Fig. 3 — DriHawk Statistics Window
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About the Statistics window

You can get a lot done in the Statistics window!

® Review the raw data from your logging session with line-by-line precision

® Check the battery status of your DriHawk Thermo-Hygrometer.

e Find statistical averages of temperature, Rh and humidity ratio for selected Log Cycles.
® Save your data to your computer's hard drive.

e Create graphs and reports for each Log Cycle.

E CREATE GRAPHS AND REPORTS

Once you've uploaded and saved your data you can produce easy-to-read graphs and reports for
the benefit of your customers. The graphs and reports from DriHawk Software help justify your
equipment decisions on the job and provide scientific verification that you left the structure
completely dry.

To create a graph of your logged data:
1 Upload and save your data from the DriHawk (refer to sections D and E).

2 In the Statistics window, select the Log Cycles you wish to graph by clicking the appropriate
check boxes. You may check as many Log Cycles as you wish.

3 Type any reference information you wish in the Notes field for each Log Cycle.
4 Select the Graph Options you wish to view by clicking the appropriate check boxes at the

bottom right of the window, e.g. Relative Humidity vs. Time, Fahrenheit or Celsius. You
may check any combination of Graph Options.
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5 Click the Graph Data button near the bottom of the window. DriHawk Software creates a
separate graph for each Log Cycle and cascades them (see Fig. 4). To tile the graphs, choose
Tile from the Window menu at the top of the screen (see Fig. 5).

Fig. 4 — Cascade view of graphs
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Fig. 5 — Tile view of graphs
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NOTE: Right-click on a graph for shortcuts to some popular options like Tile Windows,
Cascade Windows or Close All Windows. You can also choose Create Report for the active

graph.

NOTE: To return to the Statistics window, click the blue arrow in the toolbar at the top of the
screen. To return to the DriHawk Main Menu, click the Main Menu button. It's helpful to close
all graph windows before returning to the Statistics window.

To create a Daily Record of Drying Conditions report:
1 Create a graph from your logged data.

2 If you create more than one graph, select the desired graph for your report. To select a
graph, make it the active window by clicking once within its frame. This may be easier to do

in Tile view. The active window will have a highlighted title bar.

3 Choose Create Report from the Report menu at the top of the screen. You can also choose
Create Report by right-clicking on the active graph.

4 In the Report Format Data window, type your company and job information (see Fig. 6
below).

Fig. 6 — Report Format Data window
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5 Click the Next button.
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6 To print the report, select Print from the File menu at the top of the screen (see Fig. 7

below).

Fig. 7 — Print a Record of Drying Conditions Report
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To return to the Main Menu, click the blue arrow in the toolbar at the top of the screen.

F SAVE AND OPEN LOGGED DATA FILES

You can keep a record of your raw data by saving it to your hard drive where you can always

retrieve it for future reference.

To save your data:

1 Create a report with your uploaded data (refer to section E).

2 Choose Save from the File menu at the top of the screen. This saves all of your Log Cycle
data—not just the data in the report—as a DriHawk file (*.dri) for future use with DriHawk

Software.

Note: Advanced users may choose Save Data in Excel File from the Statistics window. This
saves your data as a Comma Separated Value file (*.csv) for use with spreadsheet programs like

Microsoftg, Excel.
3 Name your file according to the drying job.

4 Click Save.
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To open previously saved data:

1 In the DriHawk Main Menu, click the Open Previous Data Files button.

2 Navigate to your file in the Open window.

3 Click Open.

G TECHNICAL HELP

For technical assistance, contact:

Dri-Eaz Service Department
Monday — Friday, 7 am — 5 pm PST
Phone: 800.932.3030

Fax:  360.757.6784

Email: serve@dri-eaz.com

H REGISTER DRIHAWK SOFTWARE

Detach completed form and mail to:

DriHawk Software Registration
Dri-Eaz Products, Inc.
15180 Josh Wilson Rd.
Burlington, WA 98233

Company Name

DriHawk Software Registration Card Complete and return this card today.

By returning this card you register your version of DriHawk Data Logging Software with Dri-Eaz. Registered users receive software
technical support from the Dri-Eaz Service Department and announcements about future upgrades to DriHawk Software.

First Name Last Name

Title

DRIEAZ

Address

City State/ Province Zip/Postal Code
Country Phone Fax
Email

Date of Purchase Purchased from

Years in industry

1 Almost every day
) At least once a week ] Never
) At least once a month

What trade publications do you read most often?
U Cleanfax U Other

Number of employees

How often do you use the Internet for your business?

] A few times a year

Please rate Dri-Eaz in the following categories (5=excellent, 1=poor):
__ Product Availability
__ Educational Support
__ Technology Leader

___ Customer Service
__ User-friendly Equipment
__ Product Performance

Please share any additional comments, ideas or suggestions:

What % of your business is in water damage restoration?

| Cleaning & Restoration

U 1cs

(Please specify)

Dri-Eaz respects your privacy. We will not share your information with third parties.
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